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1 Introduction 
 
The Autodesk® Inventor® Nastran® Editor 2020 is an industry-unique tool that gives engineers greater 
control over their Nastran FEA models and results.  Features such as advanced editing, context-sensitive 
input, and dynamic help greatly increase productivity and results reliability from the start.  New advanced 
graphics option, which uses hardware acceleration, improves the performance for saving and loading 
large models, displaying and animating large results files.  Real-time results are displayed through an 
integrated post-processor, allowing users to visualize results as they are generated during the solution 
sequence.  These features combined make the Autodesk Inventor Nastran Editor an indispensable tool 
for designers and analysts alike. 
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2 Graphical User Interface 
 
Figure 1 shows the Editor graphical user interface.  Each separate Model Input File uses its own 
interface.  The interface is split into two panes.  The left pane contains the analysis options used to 
modify the analysis.  The right pane has five tabbed “folder” windows containing the following: 
 

• Nastran – The Model Input File (.NAS) 

• Analysis – The model status displayed as the analysis progresses 

• Errors/Warnings – All error and warning messages resulting from a completed analysis run 

• Summary – The Result Summary File (.RSF) from a completed analysis run 

• Output – The Model Results Output file (.OUT) from a completed analysis run 

• Model/Results – The model displayed graphically using OpenGL 
 
 

Figure 1 – Graphical User Interface 
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2.1 Message Window 

 
The Message window is shown in Figure 2 and displays general messages from the Autodesk Inventor 
Nastran solver such as an analysis start/complete message, and messages concerning model 
initialization.  This window is dockable anywhere within the Editor’s main window by clicking and 
dragging the title bar and positioning it near a border of the main window.  It may be turned on/off using 
the View menu.  It is automatically displayed when the first document is opened. 
 
 

 

Figure 2 – Message Window 

 
 

2.2 Queue Window 
 
The Queue window is shown in Figure 3 and displays the name of the currently running analysis along 
with any queued analyses.  This window is dockable within the Editor main area by clicking and dragging 
and positioning it near a border of the main window.  It may be turned on/off using the View menu.  The 
queue window will display automatically when a job is added to the queue. 
 
 

 

Figure 3 – Queue Window 
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2.3 Options View 
 
The Options view is shown in Figure 4 and enables you to view/change any and all of the analysis 
options.  The option categories can be expanded by clicking the “+” sign and collapsed by clicking the “-“ 
sign.  The Parameters/Directives tree is categorized into Basic and Advanced. 
 
 

 

Figure 4 – Options View 
 

Note: The entries in each group support context sensitive Help.  To view Help, select the option and 
press F1.  This will display the help topic for that directive. 
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2.4 Model/Results Tree View 
 
The Model/Results Tree view is shown in Figure 5. 
 
 

 

Figure 5 – Model/Results Tree View 
 
 

2.5 Model Analysis Window 
 
The Model Analysis window (Figure 6) contains the following: 
 

• Nastran – The Model Input File (.NAS) 

• Analysis – The model status displayed as the analysis progresses 

• Errors/Warnings – All error and warning messages resulting from a completed analysis run 

• Summary – The Result Summary File (.RSF) from a completed analysis run 

• Output – The Model Results Output file (.OUT) from a completed analysis run 

• Model/Results – The model displayed graphically using OpenGL 
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Figure 6 – Model Analysis Window 

 
 
2.5.1 Model Analysis View Popup Menus 
 
In the Model Analysis view, you can select any Bulk Data entry, right-click and select Convert to Fixed 

Field (Narrow).  Choosing this option will expand the entries into a fixed field (see Figure 7). 
 
 

 

Figure 7 – Model Analysis View, Convert to Fixed Field Popup Menu 
 
 
Choosing the Comment Selection or Uncomment Selection will include or exclude selected Bulk Data 
entry from the analysis, as shown in Figure 8. 
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Figure 8 – Model Analysis View, Comment Section/Uncomment Selection Popup Menus 
 
 
To generate a sensitivity study, you must convert your Bulk Data entry to a Fixed Field format.  Put your 
cursor on the entry and right-click as shown in Figure 9. 
 
 

 

Figure 9 – Model Analysis View, Generate PSHELL Sensitivity Study Popup Menu  
 
 
Selecting the Generate Sensitivity Study option will bring up a window like Figure 10.  Users can enter 
the desired thickness minimum, maximum, and number of steps.  The number of steps will determine the 
increment between the thickness minimum and thickness maximum.  The Editor will create as many 
.NAS files as you have in number of steps and automatically put them in a queue. 
 
 

 

Figure 10 – Generate PSHELL Sensitivity Study Popup Window  
 
 
2.5.2 Nastran View 
 
The Nastran view is shown in Figure 6 and displays the Model Input File (.NAS) as imported from a 
modeling program such as Femap. 
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2.5.3 Analysis View 
 
The Analysis view is shown in Figure 11and displays model status during the analysis run.  This view is 
automatically activated when an analysis is started either interactively or from the queue.  Once the 
analysis is complete, the active view will change to the errors/warnings view.  The analysis view is read-
only. 
 
 

 

Figure 11 – Analysis View 

 
 
2.5.4 Errors/Warnings View 
 
The Errors/Warnings view is shown in Figure 12 and displays all errors and warnings that occurred 
during analysis.  This view is made active when the analysis is complete.  This is a read-only view.  You 
can also view the description of the warnings or fatal errors by placing the cursor on the ID and pressing 
F1.  It will bring up the Autodesk Inventor Nastran Documentation with the information about the error. 
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Figure 12 – Errors/Warnings View 

 
 
2.5.5 Result Summary View 
 
The Result Summary view is shown in Figure 13 and displays the Result Summary File (.RSF).  This file 
is opened automatically (if it exists) when a model input file (.NAS) is opened.  It is then re-opened when 
the analysis is complete.  This is a read-only file. 
 
 

 

Figure 13 – Result Summary View 
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2.5.6 Output View 
 
The Output view is shown in Figure 14 and displays the Model Results Output File (.OUT).  This file is 
automatically opened (if it exists) when a corresponding Model Input File (.NAS) is opened.  It is then re-
opened when the analysis is complete.  This is a read-only file. 
 
 

Figure 14 – Output View 
 
 
Within the Output window, you can right-click and perform searches as shown in Figure 15. 
 
 

 

Figure 15 – Output View, Popup Menu 
 
 
2.5.7 Model/Results View 
 
The Model/Results view is shown in Figure 16 and displays the model graphically.  It uses OpenGL for 
rendering the model.  If your computer has an OpenGL capable graphics card, large models can be 
viewed interactively with good response. 
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Figure 16 – Model/Results View 
 
 
Within the Model/Results window you can right-click and choose different display options as shown in 
Figure 17. 
 
 

 

Figure 17 – Model/Results View, Popup Menu 
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By selecting Deformation Scale (Figure 17, above) the Set Deformation Scale option shown in Figure 
18 allows the user to set a deformed scaling so that the deformations can be easily viewed.  The 
Element Edges will show the element edge lines, allowing users to get a better idea of the mesh.  These 
lines can be changed via the Element Edge Color option. 
 
 

 

Figure 18 – Deformation Scale Settings 
 
 

2.6 Loading and Displaying Results 
 
After an analysis is complete, clicking on the Model/Results tab will allow the user to view a deformed 
and contoured display of the model.  The results will be loaded immediately after a Nastran run.   
 
Once results are loaded, right-clicking on a load vector will give you options such as using it to contour 
the model or deform it as shown in Figure 19.  Visualizing normal vectors or certain other results are also 
available as appropriate to the element/analysis type.  Mid-side nodes for 2D and 3D elements can now 
be visualized as well. 
 
 

Figure 19 – Displaying Results 
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2.6.1 Analysis Specific Results 
 
Additional Model/Results output features include support for GRID POINT STRESS and GRID POINT 
STRAIN, as shown in Figure 20.  Note that either the Case Control GPSTRESS or GPSTRAIN must be 
included in the Autodesk Inventor Nastran deck. 
 
Forces and Stresses due to contact are supported, when available per the Autodesk Inventor Nastran 
analysis, as shown in Figure 21. 
 
Rod and Beam output is displayed with a specific Rod (or Beam) element selection as shown in Figure 
22. 
 
For solutions involving polar and rectangular complex data, such as SOL110-Modal Complex Eigenvalue 
and SOL108-Direct Frequency Response, the results tree will also provide selections for the complex 
outputs involving phase and real and imaginary forces (Figure 23). 
 
 

Figure 20 – Displaying GRID POINT STRESS/STRAIN Results 
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Figure 21– Displaying Contact Results 
 
 

  
Figure 22 – Displaying Beam Element Results 
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Figure 23 – Displaying Complex Results 
 
 
2.6.2 Display of Composite Results 

 
When working with composites shells, the user can move from ply to ply by using the ply-up or ply-
down buttons as shown in Figure 24.  Once a ply contour is chosen (Figure 25) the user can easily view 
the same contour results for the next ply(s) by selecting the ply-down (or ply-up) buttons. 
 
 

 

Figure 24 – Ply Output Scroll Buttons 
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Figure 25 – Displaying Ply Results with Composite Shells 
 
 
2.6.3 Using Dynamic Query 

 
Dynamic query allows real-time interrogation of nodes and elements in the model.  To access this 
feature, left-click on the down arrow in the graphics toolbar as seen below in Figure 26.  You can choose 
to query nodes or elements (via property or material).  3D Query allows you to use the keyboard left and 
right arrows to drill down in the view’s z-axis.  Figure 27 shows an example of the data that is shown by 
using this query tool. 
 
 

 

Figure 26 – Dynamic Query 
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Figure 27 – Dynamic Query Popup Box 
 
 
2.6.4 Using the Highlight Option 
 
The highlight option on the graphics toolbar allows a set of nodes or elements to highlight on the model, 
in order for the user to identify their location and or properties.  See Figure 28 below.  Type in the 
Element or Node IDs in the Entity List and click Add to put them in the Selected Entities box as shown 
in Figure 29. 
 
 

 
Figure 28 – Dynamic Query 
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Figure 29 – Highlight Entity Selection 
 
 
2.6.5 Animation Setup 
 
Animations are setup using the animation icon in the graphics toolbar as seen in Figure 30.  Left-click on 
the down arrow and select the Animation Setup option.  A form as shown in Figure 31 will appear and 
allow for both single set and multi set animations (when multiple output results exist).  For multi set 
animations Number of Frames controls how many frames will be used.  The Editor will automatically 
interpolate between result sets, so a value for number of frames can be used that is higher than the 
number of increments selected.  After selecting the options in the Animation Settings, you can cycle the 
animation on/off by clicking on the main animation icon. 
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Figure 30 – Animation Setup 
 
 

 

Figure 31 – Animation Settings 
 
 
2.6.6 Results Limits 

 
The results limits feature is generally used for linear static analysis with multiple subcases.  It allows the 
user to define a range of subcases, and the Editor will plot the highest stress (or other vector) on an 
element-by-element basis.  It will essentially show you a ‘worst case’ scenario of the highest stresses on 
the model based upon the highest results from all the subcases.  The results limits feature can be 
accessed by the toolbar icon shown in Figure 32.  After clicking on the toolbar icon, the Results Limits 
window will appear as in Figure 33.  The Critical Value Threshold allows you to see how many 
elements (in percent) in the ‘critical’ subcase are over the value input (as shown in Figure 34).  
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The Factor Threshold option allows the user to pick a scale factor of the peak stress from all subcases 
(for instance if the peak stress was 1000, choosing a factor of 0.3 would set the threshold value to 300).  
The Mode area allows the user to define if the Max, Min, or Absolute Max/Min should be used to 
evaluate the Threshold value. 
 
 

 

Figure 32 – Results Limits Toolbar Icon 
 
 

 

Figure 33 – Results Limits Settings 
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Figure 34 – Results Limits View 
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3 Customizing Analysis Options 
 
Analysis options displayed in the Analysis Options view enables you to view/change all Autodesk 
Inventor Nastran model initialization directives or model parameters.  The option categories can be 
expanded by clicking the “+” sign and collapsed by clicking the “-“ sign.  A dialog box will appear by 
double-clicking the option of interest enabling you to customize that particular option. 
 
 

3.1 Integer Options 
 
The directive label is shown in the dialog title bar (see Figure 35).  The directive’s minimum and 
maximum are displayed at the bottom of the Analysis Options dialog box and the values are restricted to 
these limits. 
 
 

 

Figure 35 – Example of an Integer Option 
 
 

3.2 Real Options 
 
All real directives and parameters are edited using this dialog box, which can be seen in Figure 36. 
 
The directive label is shown in the dialog title bar.  The directive’s minimum and maximum are displayed 
and the values are restricted to these limits.  A decimal point will be automatically added if omitted.  
 
 

 

Figure 36 – Example of a Real Option 
 
 

Note:  Certain options such as K6ROT will have a check-box for the AUTO setting, as shown below 
in Figure 37: 

 
 

 

Figure 37 – Example of an Option Containing an Auto Check-box 
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3.3 File Options 
 
All file directives are edited using this dialog box (Figure 38).  When editing multiple file directives, the 
previously selected folder is set as the default. 
 
 

 

Figure 38 – Example of a File Option 
 
 

3.4 String Options 
 
The String Options dialog box is displayed by clicking on the drop-down menu next to the directive label.  
All string directives and parameters are edited using this dialog box. 
 
The directive label is shown in the dialog title bar (see Figure 39). 
 
 

 

Figure 39 – Example of a String Option 
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4 Menus 
 
This section discusses the various drop-down menus available in the Autodesk Inventor Nastran Editor. 
 

4.1 File Menu 
 
The File menu contains typical windows file menu commands as shown in Figure 40.  
 

 
 

Figure 40 – File Menu 
 
 

4.2 Edit Menu 
 
The Edit menu contains typical Windows' edit menu commands as shown in Figure 41. 
 

 
 

Figure 41 – Edit Menu 
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4.3 View Menu 
 
The View menu shown in Figure 42 controls the displaying of toolbars, windows, and field markers.  The 
Field Marker (Narrow) and Field Marker (Wide) menu items control the displaying of field markers in 
the Nastran view.  The Clear Messages menu item clears the message window. 
 

 

Figure 42 – View Menu 

 

4.4 Analysis Menu 
 
The Analysis menu is shown in Figure 43 and it controls analysis operations such as generating 
intermediate results from nonlinear analysis.  The Nonlinear Options allows Autodesk Inventor Nastran 
to generate and display intermediate results during the analysis.  These options must be turned ON 
before the analysis is started.  The Purge menu item deletes all .DAT and .TMP files (analysis database 
storage files) in the folders specified by FILESPEC1, FILESPEC2, FILESPEC3 and FILESPEC4.  The 
Reset Options menu item reinitializes the job specific .INI file to the values in the global Nastran.INI file.  
The Custom Plots menu will plot the output of user defined nodes for nonlinear and transient analyses.  
The Generate Report menu item will invoke the automatic report generator. 

 

 

Figure 43 – Analysis Menu 
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4.5 Explicit Menu 
The Explicit menu shown in Figure 44, and it is used to control explicit analysis. The Data Check option 
will run the mesh translator through the point where the explicit module has read all of the input file, computed 
the stable time increment for the model, and checked the contact conditions. It will then stop without any time 
integration. This step is required to get the average element time step information and minimum time step 

information for each element block.  

 

 

Figure 44 – Explicit Menu 

 

4.6 Setup Menu 
 
The Setup menu shown in Figure 45 contains Default Settings and Default Analysis Options menu 
items.  The Default Settings menu allows you to control Editor launch behavior, and control specific 
Editor operations.  The Default Analysis Options define the model initialization directives and model 
parameters that are associated with a new Model Input File when it is initially opened. 
 
 

 

Figure 45 – Setup Menu 

 
 
4.6.1 Default Settings – General 

 
The General options are shown in Figure 46 and set the following preferences: 
 

• The Prompt to load ASCII input/output files over box controls whether the Model Results 
Input/Output Files are loaded automatically.  Input (.NAS) and Output files larger than the 
threshold value specified will not open automatically.  

• The Close files before running analysis check-box controls whether the Model Input File is left 
loaded in memory while the analysis is run.  When this box is checked the Model Input File is 
unloaded before the analysis is run releasing memory for Autodesk Inventor Nastran to use 
during the analysis. 

• The Beep when analysis is finished check-box controls the analysis complete tone that is made 
when an analysis has finished. 

• The Enable file indexing check-box controls whether bookmarks are automatically generated for 
warnings and errors.  Note that this can slow down the Editor’s performance when running large 
models with a large number of errors or warnings. 

• The Communication Method section sets the communication method between the Editor and 
Autodesk Inventor Nastran during an analysis.  The Use Sockets method uses the network 
interface (TCP/IP).  The Editor chooses the first available TCP/IP port above 1024.  While using 
this communication method you may receive a warning message if personal firewall software is 
set up on your computer.  These messages can be safely ignored.  The Use pipes method pipes 
the Autodesk Inventor Nastran status output into the input of the Editor. 
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• The Analysis Priority slider bar controls the priority of the solver when running an analysis. 
Setting this to low can greatly improve computer usability when multitasking, with a small 
increase in solution time. 

• Note that the original default General Settings can be reset with the Reset Defaults button.  

 

Figure 46 – Default Settings, General Form 

 
4.6.2 Default Settings – Launch Behavior  
 
The Launch Behavior window is shown in Figure 47 and it determines what actions the Editor will take 
when a model input filename is specified on the Editor command line.  The various options function as 
follows: 
 

• When Open model input file (.NAS) box is checked, the Editor will open the input file supplied 
on the command line.  When the box is unchecked the file will not be opened. 

• When the Run analysis box is checked, the Editor will start the analysis automatically.  This 
prevents you from changing any options for the analysis.  When the box is unchecked, the 
analysis is not started automatically allowing you to modify the input file or change any analysis 
options you desire. 
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• The When the analysis is finished… section determines whether or not the Editor will exit upon 
completion.  When Exit the editor is selected, the Editor will close and control will be returned 
back to the calling application (usually a pre/post-processor) when the Continue button is 
pressed in the Termination Status window.  When Don’t exit is selected, you can make changes 
to the model and re-run it if desired.  Closing the Editor returns control to the calling application. 

• Note that the original default Launch Behavior can be reset with the Reset Defaults button. 
 
 

 

Figure 47 – Default Settings, Launch Behavior 
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4.6.3 Default Settings – Post Processing 
 
The Post-Processing window is shown in Figure 48 and it determines the defaults for Post-Processing. 
The Animation Default Settings allow the default number of frames and delay to be set.  The original 
default Post-Processing settings can be reset with the Reset Defaults button. 
 

Figure 48 – Default Settings, Post-Processing 
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Dynamic plots are automatically generated during nonlinear static analysis when the options “Nonlinear 
Options/Generate Intermediate Results” and “Nonlinear Options/Load and Display Intermediate Results” 
are checked as shown in Figure 49. 
 
 

 

Figure 49 – Default Settings, Results Options 
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4.6.4 Default Settings – Display Options 

 
The Display Options window is shown in Figure 50 and it determines what entities will be shown in the 
Model/Results tab.  The sub-branches under display options allow specific entities to be defaulted to 
on/off as well as their labels and colors.  The original Display Option defaults can be reset with the Reset 
Defaults button. 
 
 

 

Figure 50 – Default Settings, Display Options 
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The Load window (Figure 51) sets up a load type and displays a load symbol at the bottom right-hand 
corner of the Model/Results window.  The gravity load symbol is added when the GRAV card is included 
in the analysis as shown in Figure 52. 
 
 

 

Figure 51 – Default Settings, Load 
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Figure 52 – Gravity Load Symbol and Arrow 
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Markers for maximum and minimum values on contour plots are set to transparent to view the model at 
all times as shown in Figure 53.  The labels can be toggled on or off using the graphics view popup 
menu. 
 
 

 

Figure 53 – Max/Min for Contour 
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4.6.5 Default Settings – XY Plotting Defaults 

 
The XY Plotting Defaults window is shown in Figure 54 and determines the default plotting options for XY 
plots.  The sub-branches under XY Plotting Defaults allow for different plotting styles depending upon the 
analysis type.  The original settings for XY plots can be reset with the Reset All XY Plot Defaults button. 
 
 

 

Figure 54 – Default Settings, XY Plotting Defaults 
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4.6.6 Default Settings – XYZ Plotting Defaults 

 
The XYZ Plotting Defaults window is shown in Figure 55 and determines the default plotting options for 
3-d XYZ plots.  3-d plotting is used to display MAC (Modal Assurance Criteria) and Mass Cross-
Orthogonality Matrix plots.  These settings also apply to Rainflow and Damage matrices.  The original 
settings for XYZ plotting can be reset with the Reset All XYZ Plot Defaults button. 
 
 

 

Figure 55 – Default Settings, XYZ Plotting Defaults 
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4.6.7 Default Settings – Report Generation 

 
The Report Generation window is shown in Figure 56 and determines the default report format when 
running the report generator.  In order to use the report generator the Enable Report Writer check box 
must be checked before the analysis is performed.  Currently, only linear static analysis is supported for 
the report generator. 
 
The sub-branches allow you to setup default image views and output vectors that you want included in 
the report.  Figure 57 shows the options for the summary section of the report.  An icon appears to the 
right of the Capture Image 1 Settings box showing the default image style that is being used.  To 
change the settings, first orient the model and turn on/off the entities desired and then go into the Default 
Settings – Report Generation window and click on the Capture Image 1 Settings box to save the 
current view settings. 
 

 
Figure 56 – Default Settings, Report Generation 
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Figure 57 – Default Settings, Report Generation, Environment  
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4.6.8 Default Analysis Options Menu 
 
The Default Options form is shown in Figure 58 and selected under the Default Analysis Options 
menu.  This form sets the default options that will be used when an initialization file for an opened model 
input file (.NAS) does not exist.  This view works just like the options view discussed in Section 2.3.  The 
options are saved in the Nastran.INI file in the Autodesk Inventor Nastran installation folder. 
 
 

 

Figure 58 – Default Analysis Options Form 
 
 

4.7 Window Menu 

 
The Window menu shown in Figure 59 is used for basic Windows application functions such as: 
Cascade, Tile – Horizontally and Vertically, Close all and choosing a specific window to activate and view 
when multiple files are open. 

 
 

 

Figure 59 – Window Menu 
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4.8 Help Menu 
 
The Help menu is shown in Figure 60 and contains typical windows help menu items.  One of the most 
useful is the Nastran Help topics item.  Most of the Autodesk Inventor Nastran documentation including 
detailed cause and action formatted error message descriptions are available through a standard 
Windows Help form. 
 

 

Figure 60 – Help Menu 
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5 Creating Queues 
 

All open models are automatically added to the Default Queue.   
 
 

 

Figure 61 – Default Queue 
 

To run the queue, right-click on Default Queue and select Start Queue to start the analyses. 
 
 

 
Figure 62 – Start Queue 
 
To add a new queue, right-click on the white part of the queue window and select Add a new queue. 
 
 
 



 
Editor User’s Manual Displaying Plots 
 
 

 
 

Autodesk Inventor Nastran 2021 46 
 

6 Displaying Plots 
 
Plots can be created during a nonlinear analysis that will show maximum vector resultants vs. load 
factor.  A plot can be displayed by either right-clicking on the plot title and selecting Display, or by simply 
double-clicking on the plot title.  Only the plots with the graph icons can be displayed, as the ones without 
graph icons do not contain any data (see Figure 63).  If you display a graph while the analysis is running, 
it will automatically update the graph after each increment.  A sample plot is shown in Figure 64. 
 
 

 

Figure 63 – Display XY Plot 
 
 

 

Figure 64 – Sample Plot 
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6.1 Custom Plots 

 
Custom plotting is available through the Analysis-Custom Plots menu.  A window will appear like the 
one in Figure 65.  A sample entry is shown in the figure for node #1 in direction 3 (translation in Z). 
Multiple plots can be added by clicking Insert Plot after each one.  When the analysis is run, the custom 
plots will appear in the same lower left section where the maximum vector resultants vs. load factor plots 
are.  The custom plots (as shown in Figure 66) are accessed and work the same as the standard plots. 
 
 

 

Figure 65 – Custom Plotting Options 
 
 

 

Figure 66 – Custom Plotting Options 
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6.2 Plot Formatting 
 
A plot window can be resized and moved like any other window.  In addition, multiple plots can be 
displayed at once.  When the analysis is completed, modification of the plots is possible.  To modify a 
plot feature simply double-click on the area you want to change.  Figure 67 shows some of the plot 
settings the user can change such as font sizes, line thicknesses, text parameters, etc. 
 
 

Figure 67 – Plot Formatting Option 
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6.3 Deleting Plots 
 
Plots are deleted by right-clicking on the plot title as shown in Figure 68.  From any of the plot titles, 
either that specific plot can be chosen for deletion, or all of the plots can be deleted at once. 
 
 

Figure 68 – Deleting Plots 
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7 Nonlinear Settings 
 
By default, nonlinear static and transient status windows will appear when performing a nonlinear (NL) 
analysis (see Figure 69).  The status window shows key information such as the increment/time steps 
and the convergence of the current increment/step.  To turn it off, you can either close the window or go 
to View and uncheck the nonlinear static/transient status window option. 
 
 

 

Figure 69 – Nonlinear Status Window 
 
 
The nonlinear transient and static solution parameters (in the View menu) allow the user to modify 
nonlinear settings during an analysis.  These menus will only become active during a nonlinear analysis. 
More information about the individual entries in Figure 70 can be found in the Autodesk Nastran Solver 
Reference Guide under NLPARM (for NL static analysis) and TSTEPNL (for NL transient analysis). 
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Figure 70 – Nonlinear Solution Parameters 
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8 Toolbars 
 
Several toolbars are available to make finding information and editing data much easier with the large 
input and output files used in FEA.   
 

8.1 Standard Toolbar 
 
The standard toolbar is shown in Figure 71 and has the following icons: New, Open, Save, Print, Print 
Preview, Cut, Copy, Paste, Undo, Redo, and Find.  The toolbar is dockable anywhere within the 
Editor’s main window. 
 

 
Figure 71 – Standard Toolbar 
 
 

8.2 Query Toolbar 
 
The Query toolbar is shown in Figure 72 and is active when the output view is active.  It has the following 
icons: Find Frequencies, Calculate Critical Load, Find Epsilon, Find Maximum Applied Load, Find 
Load Vector Resultant, Find Maximum Displacement, Find Von Mises Stress, Find Matrix 
Statistics, Find Warning Message, and Find Error Message.  The toolbar is dockable anywhere within 
the Editor’s main window. 
 
 

 

Figure 72 – Query Toolbar 
 
 

8.3 Graphics Toolbar 
 
The Graphics toolbar is shown in Figure 73 and is active when the Model/Results tab is active. 
 

 

Figure 73 – Graphics Toolbar 
 
 

8.4 Standard Views Toolbar 
 
The Standard Views toolbar is shown in Figure 74 and is active when the Model/Results view is active. 
 

 

Figure 74 – Standard Views Toolbar 
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9 Field and Column Editing  
 
The Autodesk Inventor Nastran input file can be formatted using free (comma delineated) fields or fixed 8 
or 16 character fields (grid and coordinate system input only).  The Editor has several tools to make 
editing fixed field formatted files easier.  Additionally, block or column editing makes it possible to cut and 
paste columns of data using the same windows commands that are used with lines. 
 

9.1 Fixed Field Markers 
 
Often times when editing a fixed field Autodesk Inventor Nastran input file it is difficult to discern where 
the field boundaries are.  The fixed field guides shown in Figure 75 help you identify these boundaries.  
The guides can be toggled on or off by selecting the Field Marker (Narrow) or Field Marker (Wide) 
menu items in the View menu.  
 
 

 

Figure 75 – Fixed Field Markers (Narrow) 
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9.2 Field Helpers 
 
Field Helpers are lines that indicate the Autodesk Inventor Nastran fixed field boundaries and field 
numbers as shown in Figure 76.  Field helpers are inserted using the Edit menu.  The line is inserted at 
the current row number (as defined by the cursor location).  Both narrow and wide field formats are 
supported.  The line automatically starts in column 1 regardless of which column the cursor is in. 
 
 

 

Figure 76 – Field Helpers (Narrow) 
 
 

9.3 Column Editing 
 
The Editor supports the selection, copying and pasting of column data.  To select a column of data, hold 
the Alt key and highlight the selection (see Figure 77).  Once a block is selected it can be cut and pasted 
using the standard Windows edit commands. 
 
 

 

Figure 77 – Column Editing 
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10 Include File Support 
 
When the check box Display .NAS include files is turned on (under Setup-Default Settings-General), 
the Editor will automatically load all include files into the Nastran view as shown in Figure 78.  At the start 
and end of each include file there is a line delimiter displayed in red indicating the section for that include 
file.  Any changes made within the delimiters will alter the include file(s) directly.  When the include file 
feature is turned on, a modelname_temp.nas file will be created that contains all the data in the primary 
file and all include files.  This is a temporary file and can safely be deleted (if desired). 
 
 

 

Figure 78 – Include File Functionality 
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11 Report Generation 
 
The Report Generation Wizard is shown in Figure 79 and Figure 80, and is activated by going to 
Analysis-Generate Report (this can also be accessed by clicking on the report icon in the graphics 
toolbar).  In order to use the report generator the Enable Report Writer check box must be checked 
before the analysis is performed (Under Setup-Default Settings-General).  Figure 81 shows the 
conclusion section of the wizard that allows the user to directly type in (or paste in) the conclusion text.  
Currently, only linear static analysis is supported for the report generator.  See Section 1.1.1 for more 
information on how to customize the report generator. 
 

• The HTML report contains a summary of the analysis.  Other data includes group definition, 
contact definition, element initial distortion summary, applied load vector resultant, reaction load 
vector resultant, displacement data, peak displacement component, and stress result summary of 
the model. 

• Users can add their own conclusion and modify the default summary and glossary list. 

• Default images are generated for the HTML report, or users can go to “Default Setting” to setup 
their own image preference. 

 
 

 
Figure 79 – Report Wizard Cover 
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Figure 80 – Report Wizard Summary and Assumptions 
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Figure 81 – Report Wizard Conclusion 
 
 
 


